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Introduction

This course is aimed at anyone with no previous knowledge of geographical information systems (GIS). It is intended as an 
introduction to OS OpenData™ products, and how to use them in an open‑source GIS.

A GIS is a computer system capable of capturing, storing, checking, integrating, manipulating, analysing and displaying 
geographic information (GI). They can be small desktop software packages running on a single machine or very large 
network‑based systems comprising many software components across a whole organisation.

Throughout the following four exercises, you will use Quantum GIS (QGIS). This is one of many open‑source GIS products, 
which can be downloaded free of charge.	
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Exercise 1 Downloading OS OpenData

In this exercise, we will run through the process of downloading the OS OpenData products. 

1	 Firstly, you will need to download the OpenData products from Ordnance Survey’s website.  
Visit http://www.ordnancesurvey.co.uk/innovate/innovate‑with‑open‑data.html  
or follow the pathway http://www.ordnancesurvey.co.uk →Innovate → OS OpenData

 

	

Please note: Ordnance Survey OpenData consists of 11 continuously maintained products, providing information from postcodes 
and boundaries to digital backdrop maps. The 12th product, Land-Form PANORAMA, is a legacy product and is not updated.
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2	 This will open a web page where all the OpenData products are available, as either a DVD delivery or download, or both. 

	

While most of the 12 products available are downloadable at Great Britain coverage, three products (OS VectorMap District® 
Raster and Vector and OS Street View®) must be downloaded according to their 2‑letter grid reference. To choose which grid 
references you will need to download, there are a number of useful resources available:

3	 Open a new tab in your web browser and visit the Ordnance Survey ‘OS getamap™’ web page:  
http://www.getamap.ordnancesurveyleisure.co.uk/ . The Get‑a‑Map service provides Ordnance Survey Leisure maps 
online, with numerous interactive options such as creating and sharing cycling and walking routes, loading to a GPS 
device, access to the Good Pub Guide, Country Walking and Trail Magazine information. The home page can also be used to 
work out the grid reference of a particular place. 

4	 Our study area will be the Isle of Wight. Search for ‘Cowes’ in the search bar on the left‑hand side of the screen. The 
six‑figure grid reference for the centre of the screen will then be shown (see below). The first two letters are SZ, therefore 
this is the 100 km grid-square we will need to download to view Cowes within the GIS. 
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5	 This is put into context when you see the national grid in its entirety (see 
right). This is also available as the national_grid.bmp image within the 
folders OSOS_QGIS_2013 →ALL_DATA. This is an image of the national grid 
referencing system, which is used for all Ordnance Survey maps. For the 
following four exercises, we will be looking at the SZ 100 km square only.

Further information can be accessed here:  
http://www.ordnancesurvey.co.uk/resources/
maps‑and‑geographic‑resources/the‑national‑grid.html

SZ

NZNYNXNW

NUNTNSNR

NONNNMNL

NKNHNGNF

NDNCNBNA

NJ

TQ

SM TL TMSN SPSO

TFSKSJSH

TASESDSC

SR SS SUST TR

SV TVSW

HP

SYSX

TG

HZHY

HUHT

TB

OF

OW

NP OL

OQ

OV

HO

OANE

NV

NQ

SG

SB

SQ

Introduction

Exercise 1
Downloading OS OpenData

Exercise 2
Opening the OS OpenData 
products in QGIS

Exercise 3
Opening the ONS data  
in QGIS

Exercise 4
Carrying out a spatial query  
in QGIS

http://www.ordnancesurvey.co.uk/resources/maps-and-geographic-resources/the-national-grid.html
http://www.ordnancesurvey.co.uk/resources/maps-and-geographic-resources/the-national-grid.html


	 OS OpenData Masterclass	 |	 6

The GIS data are available in different formats depending on the information they contain. When we open the products 
in QGIS, this will become important. OS OpenData products are supplied in three main formats:

•	 Raster – a pixelated image; as you zoom in the pixels will become bigger, creating a blurry image. It is difficult to 
change the styling of raster products.

•	 Vector – a series of points, lines and polygons. Points are single dots, lines connect these points, and polygons are 
shapes. Upon zooming in, the map retains its clarity. It is much easier to change the styling of vector format maps. 

•	 Point – point data is a table of information that can be added to a map using a geographical reference.

For example, OS Terrain 50® is a grid and vector product, supplied in ESRI® Shape (contours), GML (contours) and ASCII Grid 
and GML (grid) formats, available at a Great Britain coverage as a download only (see below):

	

The OS OpenData products we will be using in this exercise are:
•	 OS VectorMap District® vector – a mid‑scale district map in vector format .
•	 OS VectorMap District raster – a mid‑scale district map in raster format.
•	 OS Terrain 50® – this is a height/topography product which displays 10 m contours in vector format.

6	 Select the ‘download’ option for these three products, ensuring you have selected the correct National Grid reference 
square for OS VectorMap District® (SZ), and select ‘next’. Fill in your personal details and select ‘Continue’. Enter an 
email address which you will have access to during the workshop. Once the request has been submitted, it will take a few 
minutes to two hours for the links to arrive in your inbox. 

7	 When you receive the email, the files are in a ‘zipped’ format, which greatly reduces the file size, and allows it to be sent via 
email. Right-click on the download link and save the file to a location of your choice. Once downloaded, you will need to unzip 
the files to read them in their useable formats. Once all contents have been unzipped, the original zipped file can be deleted.

Please note: These products have been pre‑downloaded to use in the following workshops and are accessible within the folder: 
OSOS_GQIS_2013 → ALL_DATA. Please use this data for this workshop.
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Exercise 2 Opening the OS OpenData products in QGIS

Throughout this exercise, we will run through how to open the OS OpenData products in QGIS (the open‑source GIS). The 
products we will be using consist of a background map for context (OS VectorMap District: raster format), a map we 
can manipulate and style to see basic infrastructure (OS VectorMap District: vector format), and a product that shows 
topography (OS Terrain 50). This exercise will therefore guide you through opening both raster and vector files within QGIS.

1	 Open QGIS 2.0.1 from Start → Programs → QQIS Dufour → QGIS Desktop 2.0.1.

2	 Firstly, we will open OS VectorMap District: raster format. Select ‘Add Raster Layer’ in the left‑hand toolbar (see right).

3	 Click ‘Browse’ and navigate to OSOD_QGIS_2013 →ALL_DATA → VectorMap_District_Raster → data. Select all the  
.tif files. Click ‘Open’.

4	 A map, similar to the one below, will appear:

Please note: In future, when opening a large number of individual raster files, it may be more efficient to input them into QGIS 
using the 'Build Virtual Raster' option (click on the 'Raster' tab, then 'Miscellaneous', then 'Build Virtual Raster (Catalog)'). Here, 
you are able to input numerous raster files, and output one .vrt file, enabling all raster files to be opened in QGIS as a single file.
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Please note: the table of contents on the left‑hand side of the screen is where the ‘layers’ are displayed. Here, each 10km raster 
square is displayed as a separate layer.

5	 Use the toolbar to zoom in/out and drag the map.

	

6	 Now is a good time to save the workspace. Select ‘Project’→ ‘Save As’ → “OSOpenData_QGIS_Workshop” (or similar), click 
‘Save’. Remember to save your work regularly.

7	 Now we will open OS VectorMap District: vector format. Select ‘Add Vector Layer’ in the left‑hand toolbar (see below).

	    
 
8	 Click ‘Browse’ and select OSOD_QGIS_2013 →ALL_DATA → VectorMap_District_Vector→ data. Change the File type to ‘ESRI 

Shapefiles (.shp)’, now select and open the following three files:

	 i.	 SZ_Building.shp
	 ii.	 SZ_RailwayTrack.shp
	 iii.	 SZ_Road.shp
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We are only looking at the basic transport network and buildings in order to get a general depiction of the land use and 
infrastructure; therefore we have only selected these three features to display. Click ‘Open’. This will bring up a map image 
similar to the one below, where the vector layers are overlaid on the raster layers:

	
 
9	 Finally, we will open OS Terrain 50®, which is also a vector product. Click on ‘Add Vector Layer’ (see below 

right); click ‘Browse’, and select OSOD_QGIS_2013 → ALL_DATA → Terrain_50 → line. Change the file type to ‘ESRI 
Shapefiles (.shp)’, select all and click ‘Open’.

Please note: In future, when opening a large number of individual vector files, it may be more efficient to input them into QGIS using 
the ‘Merge shapefiles to one’ option (click on the ‘Vector’ tab, then ‘Data Management tools’, then ‘Merge shapefiles to one’). Here, you 
can input numerous polygons, lines or points, and output one, new, shapefile. This makes it easier to edit the layers as one.
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You will see a screen similar to the one below:

	

10	 To organise the table of contents and group each collection of layers, select all the raster layers (click on the top layer, press 
shift, and click on the last layer), right click and select ‘Group Selected’. Rename the group ‘VectorMap_District_Raster’. Do 
the same for the ‘VectorMap_District_Vector’ and ‘Terrain_50’ layers. 

Please note: The position of the layers in the table of contents determines their visibility on the map. For example, the top layer 
will be visible until it is dragged to sit beneath the layer below. You can experiment with this by changing the order of the layers in 
the table of contents (drag and drop). Layers can also be turned on and off (visible and invisible) by ticking and unticking the boxes 
beside them.

11	 QGIS randomly assigns a colour to each new layer feature when it is opened. To change the style of these features, you can 
create your own style, or use pre‑designed ‘Styled Layer Descriptor’ (SLD) files, which are available to download free of 
charge from the Ordnance Survey website: 
http://www.ordnancesurvey.co.uk/business‑and‑government/help‑and‑support/products/styled‑layer‑descriptors.html

	 Some custom-made styles for use within this workshop are available within the folder OSOD_QGIS_2013  →  ALL_DATA.
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12	 In QGIS, right-click on ‘SZ_Buildings’ within the ‘VectorMap_District_Vector’ group and select ‘Properties’.

	

13	 Ensure the ‘Style’ tab on the left is active, and change the ‘Single Symbol’ selection to ‘Categorised’.
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14	 Select ‘Load style’; change the file type to SLD file (.sld), and open OSOD_QGIS_2013 → ALL_DATA. Highlight the Building_
Fullcolour.sld file and open.

	
 
15	 You will notice that the building polygon and outline labels have a minimum and maximum scale applied to each label. 

Double-click on the maximum scale of each of the three labels and change to match the selections below, also change 
the ‘label’ to match. Now when we zoom out to the extent of the Isle of Wight, the building polygons and outlines will be 
visible. Click OK.
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16	 For both the SZ_Road and the SZ_RailwayTrack layers, repeat steps 12 and 13. You will have selected ‘Categorised’ in the 
‘Layer Properties’ screen; now select the column as ‘CLASSIFICA’. Nothing will appear immediately. You now need to select 
the overall ‘Colour Ramp’ of the roads/railway tracks. 

17	 Either click on the ‘Colour Ramp’ tab and select a colour gradient of your choice and click ‘Classify’ (see below), or select 
‘load style’. Change the file type to ‘SLD File’ (.sld), select ‘VMD_SZ_Road_Style.sld’ (see below) and ‘Railway Track_
FullColour.sld’ for the appropriate feature, and click ‘Open’. Once happy with your selections, click ‘OK’.

Please note: You must first ‘delete’ any selections within the layer properties screen before editing and re‑classifying.
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18	  Now, in the table of contents, select the top OS Terrain 50 layer within the Terrain_50 group (for example, SZ29_line), 
right-click and select ‘Properties’ and then click on the ‘Load Style’ button. Change the ‘file type’ to SLD file (.sld), and 
navigate to OSOD_QGIS_2013 → ALL_DATA and select Terrain_50_style.sld. Click ‘OK’. This will have changed the colour of 
the contours of one 10 by 10 km grid. 
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19	 Right-click on the newly styled top layer, select ‘Copy Style’ (see right). Now right‑click 
on each of the remaining Terrain_50 layers and ‘Paste Style’. Continue with this 
method until all contours are a consistent style. You should now be viewing a screen 
similar to the one below:

 

	

Here OS VectorMap District raster is providing the colourful backdrop, OS VectorMap District vector is the styled layer 
showing the clusters of buildings, roads and railway networks and the distance between OS Terrain 50 contours give an 
indication of land height.
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Upon zooming in, individual houses and road network features become more clear:

Now progress to the next exercise (exercise 3) to input the additional data. 
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We have opened and styled the OS OpenData products within QGIS. Now, we will open additional datasets within QGIS, and 
assign them a geographical reference to attach the data to the map. Many OS OpenData datasets can be found at: data.gov.uk,  
including data from ONS (Office for National Statistics). A page on Ordnance Survey’s website outlines many other open data 
sources: http://www.ordnancesurvey.co.uk/innovate/geovation/data‑sources.html

We will be looking at three open source datasets:
•	 Distance to GP surgeries (in kilometres) 
•	 Percentage ageing population (% over 60s)
•	 GP surgery locations (exercise 4 only)

This information can be downloaded free of charge directly from ONS. For these exercises, it is available within the  
‘ONS_Access_data’ folder.

The first task is to assign this data a geographic location, so we can display it on the map. Firstly, we will look at the ‘Distance 
to GP’ data. As this data is in .csv (comma separate values) format, this exercise will guide you through opening delimited text 
data in QGIS. 

*Remember to save your work regularly.

1	 This exercise will follow on from Exercise 2. Keep the QGIS workspace from Exercise 2 open.

2	 Open up the Indices_of_Deprivation_2010.csv file in excel, OpenOffice Calc, or similar (OSOD_QGIS_2013  →  ALL_DATA  →  
ONS_Access_Data  →  Distance_to_GP  →  Indices_of_Deprivation_2010.csv). Browse to familiarise yourself with the data. 
Here we are mainly interested in the ‘LSOA_CODE’ column, and the ‘DIST_TO_GP’ column. 

Exercise 3 Opening the ONS data in QGIS
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Please note: The LSOA code refers to the ‘Lower Layer Super Output Area’, which is a measure of small area statistics used by ONS. 
LSOAs are used where ward boundaries are too large to store useful population data (see diagram below).

Taken from: http://www.neighbourhood.statistics.gov.uk/HTMLDocs/images/GeographyPolicy_tcm97‑51009.pdf 
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3	 The Indices_of_Deprivation_2010 data is stored as a .csv file (‘comma separated values’). To input this into QGIS, 
click on the ‘Add Delimited Text Layer’ button (see right).	

4	 Click on ‘Browse’ and select the Indices_of_Deprivation_2010.csv file to open. Ensure the CSV button is selected, 
as well as the ‘No geometry (attribute only table)’ button, as this dataset does not have point coordinates within 
it. Click ‘OK’.
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This will insert an attribute‑only layer into the layer column in QGIS (see below).

	

5	 Right-click on the ‘Indices_of_Deprivation_2010’ layer and select ‘Open Attribute Table’. Browse for reference. You will see 
that the table of data is the same as in excel. Close the table.

6	 Now, you must assign this dataset a geographical location. To do this, we will use a publicly available super 
output area dataset in vector format. Select the ‘Add Vector Layer’ button (see right and below).	

	
 
7	 Click on ‘Browse’ and select the LSOA_regions_Feb04.shp file from within OSOD_QGIS_2013→ ALL_DATA → ONS_Access_

Data → Clipped_LSOAs and Open.
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8	 This will bring up the LSOA regions for Great Britain. We now need to make sure the Coordinate Reference System is 
correct; otherwise the map will be distorted. In the bottom right hand corner of your QGIS screen, it states the coordinate 
reference system that is currently being applied. It should read:

9	 If this is correct, proceed to number 10. If not, select ‘Project’, then ‘Project Properties’. 
Select ‘CRS’ from the left‑hand column, then 'OSGB 1936 / British National Grid ESPG:27700', 
as below (If this is not within the 'Recently used coordinate reference systems', select 
from 'Coordinate reference systems of the world'  →  'Projected coordinate systems'  →  
'Transverse Mercator', or use the 'Filter' at the top of the dialog box).

	 Click ‘OK’.
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You should now see a screen similar to the one below:
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10	 You now need to join the Indices_of_Deprivation_2010 dataset to the LSOA_regions_Feb04, in order to plot the Indices_
of_Deprivation_2010 data on the map. To do this, we join the tables together. Right-click on the LSOA_regions_Feb04 
layer title, and select ‘Properties’.

	

11	 From the ‘Layer Properties’ screen that opens, select the ‘Joins’ tab in the left‑hand column, select the ‘Add Vector 
Join’ button. Fill in the ‘Add Vector Join’ screen that appears as below, selecting the following values from the 
drop‑down lists:	  

	
12	 Here, you are creating a geographical relationship between the LSOA_CODEs within the Indices_of_Deprivation_2010 

dataset and the LSOA_CODEs within the LSOA_regions‑Feb04 dataset. Click ‘OK’. 

13	 Now you are able to exit the window, although the map will not have changed. This is because the map is styled to only 
show a single colour (and therefore is not showing any attribute data). Our aim now is to create a thematic map of LSOAs 
according to the distance to a GP surgery.
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Thematic Maps: GI systems have many ways by which to analyse imported information. One of the most powerful is the ability to 
create thematic maps. Thematic maps often appear in atlases and geography text books in which the different properties of the 
objects are symbolised in some way. For example, a map of parliamentary constituencies can be coloured with a different colour to 
represent the political party holding that seat. 

14	 With the LSOA_Regions_Feb04 ‘Properties’ table open, click on the ‘Style’ tab from the left‑hand menu and select the 
‘Graduated’ option from the drop-down menu (see below).

	

15	 From the ‘Column’ drop-down selection that has now appeared, select ‘Indices_of_Deprivation_2010_DIST_TO_GP’.
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16	 Experiment with changing the ‘Colour ramp’, number of ‘Classes’ and the ‘Mode’ by which the values are categorised. In 
this example, although the ‘Mode’ selected is ‘Natural Breaks (Jenks)’, we want to create personalised bands by which the 
data is categorised.

17	 By double-clicking on any of the ‘Value’s, they become editable. Fill in the values to match those in the image below. Now 
fill in the same numbers in the ‘Labels’ column. Click ‘OK’.

	
 
18	 Finally, right-click on the LSOA_regions_Feb04 layer in the table of contents, click ‘Rename’ and type ‘Distance_to_GP’ or 

similar. 
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You have now created a thematic map illustrating the distances people have to travel to visit their GPs within LSOA 
boundaries:

	

19	 Ensure only the ‘Terrain_50’, ‘VectorMap_District_Vector’ and ‘Distance_to_GP’ layers are turned on (shown by the cross), 
with the ‘Distance_to_GP’ thematic map as the bottom layer. Which areas tend to have less distance to travel to their GP? 
Which areas tend to have more?

20	 Now, we will follow the same process to create a thematic map illustrating the percentage of people aged over 60. Repeat 
steps 3‑9, opening the file ‘Population_ages_LSOA’ LSOA’ (within OSOD_QGIS_2013→ ALL_DATA → ONS_Access_Data 
→Population_Data) rather than ‘Indices_of_Deprivation_2010’.
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21	 Right-click on the ‘LSOA_regions_Feb04’ layer in the table of contents, and select ‘Properties’. Ensure the ‘Joins’ tab is 
active, and select the ‘Add Vector Join’ button (see right). Fill in the ‘Add Vector Join’ screen that appears, selecting the 
right values from the drop‑down lists, as below:

	

22	 Click onto the ‘Style’ tab in the left‑hand column of the ‘Layer Properties’ screen. Select ‘Graduated’ from the drop‑down 
menu, and choose the ‘Population_ages_LSOA_PERCENT_AGE_OVER_60’ column to create the thematic map (see 
below). 
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23	 Change the ‘Colour ramp’ to a red gradient, and input new categorisation values as below and click ‘OK’ (Ensure you have 
chosen the colour ramp before clicking ‘Classify’ and inputting the new value boundaries, otherwise the values will be 
recalculated).

	

24	 Finally, rename the ‘LSOA_Regions_Feb_04’ layer as ‘%_over_60s’ or similar.

25	 Ensure only the ‘Terrain_50’, ‘VectorMap_District_Vector’ and ‘%_over_60s’ layers are selected, with the ‘%_over_60s’ 
thematic map as the bottom layer. Explore the map; what conclusions can you draw based on what you see? Do the areas 
with a higher percentage of people aged over 60 also have access to a good transport network?
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26	 Now we will combine the two thematic maps to provide an overall analysis of the LSOA regions based on distance to a GP 
surgery, and percentage ageing population. Right-click on the ‘%_over_60s’ layer and select ‘Properties’. Move the ‘Layer 
transparency’ indicator to ‘50’ (see below) and click OK.
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27	 Ensure only the ‘%_over_60s’ and ‘Distance_to_GP’ layers are both selected. The darker LSOA regions on the map are the 
ones with a higher percentage of people aged over 60 and a further distance to travel to reach a GP:
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28	 Now, overlay the Terrain_50 layer. What interpretations can you make based on what you can see?
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In this exercise, we will plot GP surgeries on the map. This will allow us to build up a more detailed picture of GP location data. 
For example, the GP surgeries located within LSOA boundaries are not necessarily in the centre. People within the LSOA may 
still have difficulty accessing GP facilities. Using this data, we will then identify the LSOAs which contain a GP surgery, by 
performing a spatial query. 

1	 Open the saved workspace from exercise 3 in QGIS.

2	 Click on the ‘Add Delimited Text File’ button.

3	 Click ‘Browse’, and select the ‘GP_Locations_2013_LSOA’ file within OSOD_QGIS_2013 → ALL_DATA →ONS_Access_data → 
GP_Locations. This file contains geographical information, in the form of northing and easting point coordinates. Ensure 
the screen looks like the one below, and click ‘OK’.

	

Exercise 4 Carrying out a spatial query in QGIS
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4	 Select the 'OSGB 1936 / British National Grid ESPG:27700' Coordinate Reference System (If this is not within the 'Recently 
used coordinate reference systems', select from 'Coordinate reference systems of the world'  →  'Projected coordinate 
systems'  →  'Transverse Mercator', or use the 'Filter' at the top of the dialog box). Click 'OK'.
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This will bring up the GP surgeries onto the map as a separate layer, as below:

	

5	 Now, we will determine which LSOAs contain a GP surgery, and which do not. To do this, we perform a spatial query. 
Firstly, we must open up the LSOA boundary vector dataset. Click ‘Add Vector Layer’, and select the ‘LSOA_regions_Feb04’ 
shapefile. Click ‘Open’. 

6	 Now, click on the ‘Vector’ tab, then ‘Spatial Query’ as below. You may need to install the plugin, if it is not shown in the 
Vector tab. To do this, go to ‘Plugins', select ‘Manage and Install Plugins...', and select ‘Spatial Query Plugin' (x).
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7	 Fill in the screen, as below, and click ‘Apply’:

	

8	 This will bring up another screen summarising the query and showing how many selections have been made (that is, how 
many LSOAs contain a GP surgery, see below). Click ‘Close’.

	

Introduction

Exercise 1
Downloading OS OpenData

Exercise 2
Opening the OS OpenData 
products in QGIS

Exercise 3
Opening the ONS data  
in QGIS

Exercise 4
Carrying out a spatial query  
in QGIS



	 OS OpenData Masterclass	 |	 36

You will see a screen similar to the one below:

	

Here the yellow areas represent those LSOAs which contain a GP surgery. 

We now need to save the selection to remove those LSOAs which do not contain a GP surgery (the green areas) in order to 
interpret the map more effectively.
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9	 Right-click on the ‘LSOA_regions_Feb04’ layer within the table of contents; select ‘Save Selection As’ (see below).

	

10	 Click on ‘Browse’ and select a location you can easily access, for example within the OSOD_ QGIS_LSOA_2013 folder. Name 
the vector layer ‘LSOA_containing_GPs’ or similar. Check the box ‘Add saved file to map’, as below. Click ‘OK’. 
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11	 You can now delete the LSOA_regions_Feb04 layer. Right-click on the layer in the table of contents and select ‘Remove’.

12	 Right-click on the new ‘LSOA_containing_GPs’ layer, click ‘Properties’, and change the ‘Border style’ to ‘No Pen’, as below. 
Change the fill colour if you wish. 
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The resulting map should look similar to the one below:

	

How does the addition of this new layer affect the way you view the case study? Open up all the layers together. Are there any 
unusual results? (Clue: does the ‘Distance to GP’ and ‘GP location’ data agree?) What conclusions can you draw from this?
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